Technology for Teachers

Current teachers must be able to use technology, teach students how to use technology, and even fix what’s broke! All schools have websites and expect their teachers to have sites that provide information regarding schedules, homework, special projects and deadlines, and information about themselves.

The Center for Teacher Certification provides numerous experiences for new teachers to be prepared before the school year begins, by setting up a website, designing, and uploading documents that will be used during the school year.

Your campus and school may have the latest, cutting edge equipment or older equipment that is not usable. You are expected to “make it work” and use the technology for communication, keeping grades and attendance, allowing students to learn technology skills and use the Internet as a resource.

Standards

Find the Technology Standards at the State Board for Educator Certification (SBEC) at http://www.sbec.state.tx.us/SBECOnline/standtest/standards/techapps_allbegtch.pdf. Note that: These Technology Applications standards are expected of ALL beginning teachers and will be incorporated into the EC-12 TExES exam for Pedagogy and Professional Responsibilities.

As shown below, the basic competences are laid out, with following pages dedicated to specific competencies. Download the document and check through your current technology skills.

**TECHNOLOGY APPLICATIONS STANDARDS FOR ALL BEGINNING TEACHERS**

*Standard I.* All teachers use technology-related terms, concepts, data input strategies, and ethical practices to make informed decisions about current technologies and their applications.

*Standard II.* All teachers identify task requirements, apply search strategies, and use current technology to efficiently acquire, analyze, and evaluate a variety of electronic information.

*Standard III.* All teachers use task-appropriate tools to synthesize knowledge, create and modify solutions, and evaluate results in a way that supports the work of individuals and groups in problem-solving situations.

*Standard IV.* All teachers communicate information in different formats and for diverse audiences.

*Standard V.* All teachers know how to plan, organize, deliver, and evaluate instruction for all students that incorporates the effective use of current technology for teaching and integrating the Technology Applications Texas Essential Knowledge and Skills (TEKS) into the curriculum.

*Standard VI.* Beginning teachers who are not technology application specialists are not responsible for this standard.

List the skills you need in learning, applying, or mastering and email us those skills. We provide Saturday School once per month for time with the technology instructor.
The Teacher Certification program covers these topics:

1.10s use a variety of input devices such as mouse/track pad, keyboard, microphone, digital camera, printer, scanner, disk/disc, modem, CD-ROM, and joystick;

1.14s discuss copyright laws, violations, and issues including, but not limited to, computer hacking, computer piracy, intentional virus setting, and invasion of privacy;

1.16s demonstrate proper etiquette and knowledge of acceptable use of electronic information and products while in an individual classroom, lab, or on the Internet or an intranet;

2.6s determine and employ methods to evaluate electronic information for accuracy and validity;

2.7s resolve information conflicts and validate information by accessing, researching, and comparing data from multiple sources;

3.3s plan, create, and edit databases by defining fields, entering data, and designing layouts appropriate for reporting;

3.4s demonstrate proficiency in the use of multimedia authoring programs by creating linear or nonlinear projects incorporating text, audio, video, and graphics;

3.7s integrate two or more productivity tools, including, but not limited to, tables, charts and graphs, graphics from paint or draw programs, and mail merge, into a document;

3.11s participate in electronic communities as a learner, initiator, and contributor (email and websites);

3.14s use technology in self-directed activities to create products for and share products with defined audiences;

3.16s design and implement procedures to track trends, set time lines, and review/evaluate progress for continual improvement in process and product (EDTC 3005);

4.1s use productivity tools, such as slide shows, posters, multimedia presentations, newsletters, brochures, or reports, to create effective document files for defined audiences;

4.2s demonstrate the use of a variety of layouts in a database, including horizontal and vertical layouts, to communicate information appropriately;

4.3s create a variety of spreadsheet layouts containing descriptive labels and page settings;

4.10s determine and employ technology specifications to evaluate projects for design, content delivery, purpose, and audience and demonstrate that process and product can be evaluated using established criteria or rubrics;

4.12s evaluate products for relevance to the assignment or task.

5.1s plan applications-based technology lessons using a range of instructional strategies for individuals and small/whole groups;

5.2s identify and address equity issues related to the use of technology, including, but not limited to, gender, ethnicity, language, disabilities, and student access to technology;

5.4s develop and implement, using technology applications, tasks that emphasize collaboration and teamwork among members of a structured group or project team;

5.5s provide adequate time for teaching the Technology Applications TEKS;
5.6s identify and use resources to keep current with technology education;

5.7s create project-based learning activities that integrate the Technology Applications TEKS into the curriculum and meet the Technology Applications TEKS benchmarks;

5.8s follow guidelines for the legal and ethical use of technology resources;

5.9s select and use developmentally appropriate instructional practices, activities, and materials to improve student learning of the Technology Applications TEKS;

5.11s teach students how to locate, retrieve, and retain content-related information from a range of texts and technologies;

5.12s teach students how to locate the meanings and pronunciations of unfamiliar content-related words using appropriate sources, such as dictionaries, thesauruses, and glossaries;

5.13s use technology tools to perform administrative tasks such as taking attendance, maintaining grade books, and facilitating communication;

5.14s evaluate appropriately students’ projects and portfolios using formal and informal assessment methods;

5.15s collect observable and measurable data to gauge student progress and adjust instruction in Technology Applications;

**Notes:**
ACC Communication Requirements

Having current information, updated regularly, is important to the program and meeting SBEC standards. As you switch to a teaching career, we want you to thoughtfully choose this career, train, and continue professional development in knowing how to teach each student.

3.11s participate in electronic communities as a learner, initiator, and contributor (email and websites);

3.14s use technology in self-directed activities to create products for and share products with defined audiences;

When the information on your initial application changes, we ask that you inform our office of any changes (name, address, phone numbers, email address, website address, campus, mentor, principal, etc.) We will keep up with you for five years.

We have set up an ACC TCP email for each cohort group. As soon as you are accepted into the program, you may set up your account. Follow these directions

ACC Teacher Certification Yahoo Account

Everyone in the program will be using a Yahoo account in order to keep it simple and also necessary for your Geocities Website. Even if you already have an existing Yahoo account, create a new account specifically for this program.

To create your new Yahoo account

1. Go to www.yahoo.com
2. Click on the “Sign Up” link
3. A form will appear with various questions. The first section will be most important in terms of this program. All participants in this program will use the same format for their Yahoo ID. Your ID will begin with acctcp5_(the first letter of your first name)(your last name). For example, if your name is Gloria Gonzales, your Yahoo ID will be acctcp5_ggonzales
4. If for some reason the Yahoo ID you are attempting to create is not available please contact Gloria.

5. In another area of the Sign Up form, you will be asked for an alternate email. Once you have submitted the Sign Up form, a confirmation email will be sent to your alternate email address. For security reasons, you will need to verify your new Yahoo email address by clicking on the verification link within the email sent to you.
Once you have paid for EDTC 3000 (due by December 15), you can access the program and courses at [http://www.austincc.edu/teacher](http://www.austincc.edu/teacher).

Cohort page: username teacher; password teacher.

You will apply for a web page of your own and upload documents to your personal page in the form of a portfolio that remains throughout the training. Consult our Technology Integration Specialist for assistance.

Remember that you are responsible for all course requirements and attendance. Check the training page and your acctcp Yahoo email daily to get the latest updates. When you miss class, you must immediately make up the work. Remember that you must earn an 80 or higher to remain in the program.
1.10s use a variety of input devices such as mouse/track pad, keyboard, microphone, digital camera, printer, scanner, disk/disc, modem, CD-ROM, and joystick;

1.16s demonstrate proper etiquette and knowledge of acceptable use of electronic information and products while in an individual classroom, lab, or on the Internet or an intranet;

3.4s demonstrate proficiency in the use of multimedia authoring programs by creating linear or nonlinear projects incorporating text, audio, video, and graphics;

3.11s participate in electronic communities as a learner, initiator, and contributor (email and websites);

3.14s use technology in self-directed activities to create products for and share products with defined audiences;

4.10s determine and employ technology specifications to evaluate projects for design, content delivery, purpose, and audience and demonstrate that process and product can be evaluated using established criteria or rubrics;

Creating a Website with Yahoo! GeoCities is affordable and easy to accomplish. Because of the number and size of files we will be uploading to our websites during this program, it will be necessary to purchase the Yahoo! GeoCities Plus account. This account will allow for 500MB of space for $4.95 a month (plus a $10 setup fee). This documentation provides you with a basic outline on successfully publishing, editing, and uploading files to your Website.

Let’s get Started with Yahoo! GeoCities

2. This page is titled ‘Choose Plan’; simply verify you selected the GeoCities Plus plan with 500 MB disk space included.
3. Next, you will need to sign in using your acctcp5_yourname login and password.
4. The third screen, ‘Enter Billing Info’ will require a credit card for payment of your GeoCities Plus account.
5. The last screen, ‘Review and Confirm Order’ will review the amount to be charged to your credit card each month. This charge will be automatically billed until you cancel the GeoCities Plus account. Click the ‘Place My Order’ link when you have reviewed the screen.
6. Congratulations, you have just set up your Yahoo! GeoCities account. This window takes you into the Control Panel. In addition, this window provides the URL (web address) for your new website.

Logging In
Anytime you want to work on your website, all you need to do is log back into the Yahoo! GeoCities site

1. Go to http://geocities.yahoo.com
2. In the ‘Sign in’ area type in your username and password (depending on your computer setting, you may not have to log in each time).
Using the Control Panel
Yahoo! GeoCities makes it very easy to create, update and manage your website by providing a 'Control Panel'.

GeoCities Control Panel

Each of these tabs has specific functionality for your Website. The ‘Home’ tab contains the Getting Started items, Site Status, and Site Activity. Under the Getting Started section is the GeoCities Tour, an excellent overview of the tools.

1. Click on the ‘GeoCities Tour’ icon.
2. Click on each button at the bottom of the new window to complete the tour.

Starting Your Website
1. Under the ‘Home tab’, click on the ‘Create a Web Site’ icon.
2. This window gives you various options for constructing your Website, click on the ‘Try PageBuilder’ link. This easy to use software allows you to create a full-featured site without any HTML coding. You can customize your pages with pictures, files, sounds, and more.

Using PageBuilder: The Basics
1. The PageBuilder tutorial provided will save you time and energy. Click on the ‘PageBuilder Tutorial’ link to get started. This link will take you to another screen where you will need to click the ‘Begin the tutorial’ button to launch the tutorial.

2. After you have completed the tutorial, you will return to the main PageBuilder screen. To begin using PageBuilder you should select a template. There are numerous templates to choose from, including a blank template. After looking over the templates click on the one you would like to use for your Website.

3. Once you click on the template, a new window will open informing you that Yahoo! PageBuilder is loading. Depending on your connection speed this may take a few minutes.

4. After the program had downloaded it will open with the template you selected. If you do not like the template you selected, you can select a different template by clicking on File -> New Page from Template.
5. After you have selected the template for your Website, you should save your first page. This first page is called the ‘index’ page and should function as a table of contents. From this main page, a visitor can access all the other WebPages on your Website. On the PageBuilder toolbar click the ‘Save’ icon and choose index from the dropdown menu. As you continue to make changes to this page, simply click the ‘Save’ button again, this will overwrite your previously saved version.

**Using PageBuilder: The Basics**
When you selected the PageBuilder template, you were provided with a generic page layout. There are numerous methods for altering this layout.

- To remove an element, select the object (you will know an objected is selected when the handle boxes appear at the corners) and click the Delete button on the PageBuilder toolbar or the delete key on your keyboard.
- If you need additional text boxes and want the same formatting as the text boxes already on the Webpage, select an existing text box and click the Duplicate button on the PageBuilder toolbar. You will need to drag the newly created textbox to the appropriate location on the Webpage.
- To create new elements, simply click on the desired element from the PageBuilder toolbar.

**Using PageBuilder: Creating Hyperlinks**
As with any Webpage, you can create hyperlinks to other WebPages, files, or email addresses. Your Website will most likely use all of the above.

To create a hyperlink:
1. Highlight the text to be hyperlinked and click on the Link button from the PageBuilder toolbar.
2. This will open the Hot Link window, from this drop-down menu you can choose to link to a Web URL (any Website), My Page (any Webpage you have created with this GeoCities PageBuilder account), Email (have the default email program send email to the specified email address), and My File (any of the documents you create; for example Word files, PowerPoint files, etc.).

   ![Hot Link Window](image)

   - To link a Web URL, simply type in the URL in the box to the right.
   - To link to My Page, click on the ‘Choose…’ button and select the desired Webpage from the ‘Pick File’ window.
   - To link to an Email, type in the email address in the box to the right.
   - To link to My File, click on the ‘Choose…’ button and select the desired file from the ‘Pick File’ window.

**NOTE:** Only files that have been properly uploaded will appear in the ‘Pick File’ window.

**Uploading Files**
In order to link your own personal files, you will need to upload your files to GeoCities.

1. Go to the GeoCities Control Panel: Create and Update tab.
2. On the ‘Create and Update’ page there is a section labeled ‘File Management Tools’. Within the ‘File Management Tools’ section, click on the ‘Easy Upload’ link.
3. By clicking the on the ‘Browse…’ button you can select the file to be uploaded. Using this tool you can load more than one file at a time.

4. Once you have selected the files to be uploaded, click the ‘Upload Files’ button.

The website that you construct is valuable not only in learning the technology but use in publicizing your abilities to potential principals. The principal is likely to pick one of you for employment and perhaps pass on names to other principals, so when we ask, “Would you employ this person?” we mean it. Principals want to know about you, goals, background, and technology ability. This is the best way to project that snapshot. Include your web address on your resume.

Please update your website regularly so you will have a worthy website ready for school. State when you have passed your exams, that you have passed 2/4 ACC courses, etc.